
Digital Multimedia/Graphic 
Communication: Sem. 1 Study Guide 

What was this course’s main purpose: 

In this course, you will learn about the most important features of Adobe 
InDesign CS6, Adobe Illustrator CS6, and Adobe Photoshop CS6. Starting with 
Photoshop, you will learn how to work with layers, make selections, incorporate 
color techniques, and place type in an image.  Then, with Illustrator, you will 
learn how to create text and gradients, draw and compose an illustration, 
transform and distort objects, and work with layers. Finally, with InDesign, you 
will learn how to set up a document and work with text, frames, and colors. In 
the concluding chapter of the book, you will create a final project that integrates 
what you have learned about the three programs. 

The graphic to the left summarizes the course description by asking the 
user, WHAT ARE YOU TRYING TO CREATE. 

What Did We Learn 

This course was broken down into 6 sections (2 per card marking).  While they 
did not always follow a chronological order, each section had a in class 
assignment as well as a project challenge dedicated to understanding the 
concepts from each section: 

  Basic Computer 
and Mac Concepts 

Getting Started 
with Adobe 
Photoshop CS6 

Learning 
Photoshop Basics 

Working with 
Layers 

Making Selections  Placing Type in an 
Image 

Card Marking 1  MAC basics 
 
Logging on 
 
Operating software 
Operating 
hardware 
 
Basic Computer 
terminology 
 
Dealing with Errors 
 

Start Adobe 
Photoshop CS6 
 
Learn how to open 
and save an image 
 
Examine the 
Photoshop window 
 
Close a file and exit 
Photoshop 

Use organizational 
and management 
features 
 
Use the Layers and 
History panels 
 
Learn about 
Photoshop by using 
Help 

     

Card Marking 2        Examine and 
convert layers 
 
Add and delete 
layers 
Add a selection 
from one image to 
another 
 
Organize layers 
with layer groups 
and colors 

Make a selection 
using shapes 
 
Modify a marquee 
 
Select and using 
color  

 



Card Marking 3           
 

Learn about type 
and how it is 
created 
 
Change spacing  
 
Use the Drop 
Shadow style 

 

Mac and Apple Terminology 

Definitions of common terms, words, and technical 
jargon associated with Apple and the Macintosh 
computer. To find a term quickly use ⌘ F (Command 
Key %2B F) to open a search box and type in the term. 

Keyboard Symbols: ⇧ shift key, ⌘ command key, ⌃ 
control key, ⌥ option key, ⇥ tab key, ⎋ escape key 

Adware – Adware is a type of spyware that collects 
information about your buying habits, as well as the web 
sites you visit. Adware uses the information it collects to 
display advertising in your web browser or other 
applications that is keyed to your particular interests. 

Alt key (⌥ ) – Also called the Option key. Used in 
conjunction with other keys for access to special 
functions. Found at the bottom of the keyboard just to 
the left of the Command key. 

Apple Menu – The Apple menu provides access to 
items and services that are always available, regardless 
of which application is currently active. The Apple menu 
includes the Sleep, Restart, and Shut Down commands 
and more. 

Application – An application is a software program 
designed to perform one or more computer functions. 

Backspace / Delete Key – Used to erase selected items 
or letters to the left of the blinking cursor. Bluetooth – A 
wireless technology designed for transmitting data over 
short distances (between 1 and 100 are 
Bluetooth-enabled. 

Click – One click of the mouse button. Used to select a 
document, insert the cursor or activate a tool. 

Click & Drag – to Click and hold down the mouse button 
while dragging the mouse. Done to select objects, or to 

draw & also used to drag a selected object to a new 
location, or to open a menu. 

Close – (⌘ W) Found under the File menu. Used to put 
away documents or close folders. Use either the 
quick-key combination or select the Close menu 
command. It will not cause a program to quit (with the 
exception of Control Panel programs). Command key – 
The key with the Apple and/or clover-leaf (⌘) symbol 
(usually next to the space bar). Mainly used where you 
would use the Control key on Windows. 
Command-clicking – Refers to holding down the 
Command key and clicking the left (or single) mouse 
button. 

Control-clicking – Refers to holding down the Control 
key and clicking the left (or single) mouse button. Has 
the same effect as right-clicking with a 2-button mouse.  

Copy – Found under the Edit menu (⌘ C) – Used after 
selecting a portion of text, sound, etc to be copied. 
Selection is most often accomplished by click/dragging 
over the item.  

Crash – When a program encounters an error in its 
operation, it may freeze up and stop working. The 
program may even automatically quit. When this 
happens, it is advisable to quit all other programs and 
restart the computer, thus refreshing the operating 
system and restarting the programs from scratch. 

Cursor – The blinking line found at the active point of 
keyboard input. It is repositioned by mouse clicking in a 
new position pointed to by the Mouse Arrow.  

Cut – Found under the Edit menu – (⌘ X) Used to erase 
a selected area or object from a document. This action 
places the cut item in temporary memory (clip board) 
that can be pasted into other areas and/or documents.  



Dashboard – Dashboard creates a special layer in the 
Mac OS X operating system for running 
mini-applications called widgets. 

Desktop – The Desktop folder and the Mac desktop 
provide two different views of the same information. The 
desktop is the first thing you see after you log in to your 
Mac. 

Document – the data generated by operating a 
program.  

Dock – The Dock is a ribbon of icons that serves several 
purposes. You can launch an application from its icon in 
the Dock; check the Dock to see which applications are 
currently active; and add icons to the Dock for easy 
access to your favorite applications, folders, and files.  

Double click – Two fast clicks of the Mouse Button. 
Used to open documents and Launch applications. May 
also be used to select a word in a text document instead 
of click/dragging over the word.  

Drag – Used in conjunction with a click of the mouse. 
Moves the selected item to a new location or moves the 
cursor across text or data in a sound file.  

Eject – Ejects the disk in the Disk Drive 

File Menu- Found at the top of the Macintosh screen, it 
is used to open or close documents, as well as print, 
save & quit operations. Finder – The app that lets you 
view and manipulate files and folders. It’s the first app 
you see when you first log in to your Mac. You can 
switch to the Finder by clicking the Finder icon on the left 
hand side of the Dock. 

Flash drive – Consists of a small data storage device 
with USB connector which can be carried in a pocket or 
on a keychain. USB flash drives are typically removable 
and rewritable. Drives of up to 256 GB are available and 
storage capacities as large as 2 TB are planned. Also 
known by other names, ie. thumb drive.  

Flash storage – Essentially a really big USB memory 
stick instead of using a standard Hard Drive which stores 
information on disks inside the drive. Flash is very fast, 
reliable, durable and only takes minimal space. Flash 
memory looks pretty much like RAM-sticks. (Also see 
SSD.)  

Folder – Similar to a file cabinet folder, it is used to 
contain related documents.  

Force Quit – Stop an application running immediately. 
Force quitting is useful if an application has “hung” 
(become unresponsive and is displaying the spinning 
beach ball of doom. To force quit an app, switch to 
another app (such as the Finder) then choose Force Quit 
from the Apple menu. 

GB – Gigabyte – a unit of measurement of storage. A 
gigabyte is a thousand million bytes (though it can 
sometimes be slightly higher than this, depending on 
interpretation). One byte is enough to store a single 
letter of the alphabet. Commonly used to refer to RAM 
and hard disk size. 

Hard Drive – A hard drive is a mechanical method of 
storing digital information. There are two important 
things to be aware of when you’re in the market for a 
hard drive: capacity and interface type.  

Hardware – In terms of computers, hardware usually 
refers to external components, such as printers or 
scanners, that you can see or touch. Some internal 
computer components, such as the processor and 
memory, are also called hardware. 

Icon – A shape representing a document, program or 
disk. It may look like a folder or a program graphic. 

Inkjet Printer – An inkjet printer uses specially designed 
print heads that can spray ink directly onto paper in 
specific patterns. Most inkjet printers are four-color 
printers (cyan, magenta, yellow, black), although 
six-color and eight-color printers are also available. 

Laser Printer – A laser printer is a printer that uses a 
light source (usually a laser) to project onto a charged 
surface (usually a rotating drum). Laser printers are 
available in color and monochrome versions, in a wide 
variety of price ranges. 

Menu Bar – The Mac OS X menu bar is a thin horizontal 
bar that spans the top of the Mac desktop. The menu bar 
always contains the Apple menu (identified by an Apple 
logo icon), as well as the basic File, Edit, View, 
Windows, and Help menu items. The menu bar may also 
contain items placed there by currently active 
applications. Unlike the Dock, the menu bar cannot be 
moved to other locations.  



Menu Select – Click and drag down to the desired menu 
item; release the mouse to activate the command 

Optical Drive – In addition to a hard drive, most desktop 
and laptop computers come with an optical drive, which 
is designed to read or read and write optical media (CDs 
and DVDs). 

Option key – A modifier key like Command or Control 
(usually sits between the Command and Control keys on 
the keyboard). Often used for secondary actions, or for 
entering accented characters. May be labelled, Alt, 
Option, or ⌥. 

Password – A special and unique word that is used to 
verify that the individual is a registered & authorized 
user.  

Paste – Found under the Edit menu (⌘ V) – Used to 
insert information that was cut or copied from one 
location to another. Also used for making multiple copies 
of a section or object. 

Quit – Found under the File menu (⌘ Q) when working 
in an application. Used to stop all activity in that program 
and go back to the desktop. 

RAM – RAM (Random Access Memory) is a computer’s 
main memory. RAM temporarily stores parts of the 
operating system and any applications you run, to allow 
faster access to data. 

Save – Found under the Edit menu (⌘ S) – This 
updates all data and should be done every few minutes 
or so if you are working vigorously.All changes made to 

a document after the last save will be lost if there is a 
crash. 

Select – single clicking an item or click dragging (high 
lighting) a selection of objects. Whole words may be 
selected by double clicking on the word. 

Sleep – Allows you to “turn off” your Mac, conserving 
power, without actually having to restart the Mac from 
scratch when you turn it back on. Macs support various 
sleep modes: Quick sleep, which keeps the memory 
powered up; Deep sleep (or hibernation), which writes 
the memory contents to disk and completely powers off 
the Mac; and Safe sleep, which keeps the memory 
powered but also writes the memory contents to disk in 
case there’s a power failure. Most desktop Macs default 
to Quick sleep, while most MacBooks default to Safe 
sleep. 

Toolbars – Areas containing tools specific to that 
program; found at the edges of the screen. Individual 
tools are selected by clicking them.  

Trash – The Mac’s Trash can temporarily holds any files 
and folders that you have deleted. You can delete a file 
or folder by dragging it to the Trash icon in the Dock. To 
delete the contents of the Trash permanently, right-click 
or Control-click the Trash icon and choose Empty Trash. 

USB – USB (Universal Serial Bus) is a uniform 
connector designed to simplify the process of connecting 
peripherals, such as printers or keyboards, to a 
computer. 

  



Glossary of Terms Used By Card-Marking/Section 

Card-Marking 1 / Section 2 
Photoshop Basics 
 
History panel 
Contains a record of each action performed during a 
Photoshop session. Up to 1000 levels of Undo are available 
(20 levels by default). 
 
Landscape orientation 
An image with the long edge of the paper at the top and 
bottom. 
 
Layer 
A section within an image on which objects can be stored and 
individual effects can be isolated and manipulated without 
affecting the rest of the image. 
 

Layers panel 
Displays all the individual layers within an active image. You 
can use it to create, delete, merge, copy, or reposition layers. 
 
Matte 
A colorful box (often without shine) placed behind an object 
that makes the object stand out. 
 
Orientation 
Direction an image appears on the page, either portrait or 
landscape. 
 
Portrait orientation 
An image with the short edge of the paper at the top and 
bottom. 

 
Card-Marking 2 / Section 3 
Working with Layers 
 
Blending mode 
Affects the layer's underlying pixels or base color. Used to 
darken or lighten colors, depending on the colors in use. 
 
Crop 
To exclude part of an image. It hides areas of an image without 
losing resolution quality. 
 
Flattening 
Merges all visible layers into a single Background layer and 
discards all hidden layers. 
 
Layer group 
An organizing tool you use to associate layers on the Layers 
panel. 
 
Layer thumbnail 

Contains a miniature picture of the layer's content, and 
appears to the left of the layer name on the Layers panel. 
 
Marquee (or Marching Ants) 
A series of dotted lines indicating a selected area that can be 
edited or dragged into another image. 
 
Merging 
Combining multiple image layers into a single layer. 
 
Object layer 
A layer containing one or more images. 
 
Opacity 
Determines the percentage of transparency. 
 
 

 
Card-Marking 2 / Section 4 
Making Selections 
 
Selection 
An area in an image that is surrounded by a selection marquee 
and can then be manipulated. 
A command that removes the marquee from an area so it is no 
longer selected. 

Handles 
Small boxes that appear along the perimeter of a selected 
object and are used to change the size of an image 

Mask 
A feature that lets you protect or modify a particular area; created using a marquee. 

 
Card-Marking 3 / Section 5 



Incorporating Color Techniques 
 
Background color 
White by default, it is used to make 
gradient fills, and to fill in areas of an 
image that have been erased. 
 
Base color 
The original color of the image. 
 
Bitmap 
A geometric arrangement of different 
color dots on a rectangular grid. 
 
Blend color 
The color you apply with a paint or edit 
tool. 
 
Blending mode 
Controls how pixels are made either 
darker or lighter based on underlying 
colors. 
 
Brightness 
The measurement of relative lightness 
or darkness of a color (measured as a 
percentage from 0% [black] to 100% 
[white]). 
 
CMYK mode 
Using a color system, containing at 
least four channels (one each for cyan, 
magenta, yellow, and black). 
 
 
Color mode 
Used to determine how to display and 
print an image. 
 
Color Picker 
A feature that lets you choose a color 
from a color spectrum or numerically 
define a custom color. 

 
Filters 
Photoshop commands that can 
significantly alter an image's 
appearance. 
 
Foreground color 
Used to paint, fill, and stroke 
selections. The default foreground 
color is black. 
 
Gradient 
A blend of colors used to fill a selection 
of a layer or an entire layer. 
 
Gradient fills 
A type of fill in which colors appear to 
blend into one another. Determined by 
its beginning and ending points. 
 
Gradient presets 
Predesigned gradient fills that are 
displayed in the Gradient picker. 
 
Grayscale images 
Can contain up to 256 shades of gray, 
assigning a brightness value from 0 
(black) to 255 (white) to each pixel. 
 
 
 
 
Grayscale mode 
Uses up to 256 shades of gray, 
assigning a brightness value from 0 
(black) to 255 (white) to each pixel. 
 
Hexadecimal value 
Sets of three pairs of letters or 
numbers that are used to define the R, 
G, and B components of a color. 
 

Hue 
The color reflected from/transmitted 
through an object and expressed as a 
degree (between 0° and 360°). Each is 
identified by a color name (such as red 
or green). 
 
Pixel 
Very small squares that make up an 
image; each dot in a bitmapped image 
that represents a color or shade. 
 
RGB mode 
Using a color system, containing at 
least three channels (one each for red, 
green, and blue). 
 
Sampling 
A method of changing foreground and 
background colors by copying existing 
colors from an image. 
 
Saturation 
The strength or purity of the color, 
representing the amount of gray in 
proportion to hue (measured as a 
percentage from 0%, to 100%. Also 
known as chroma. 
 
 
 
Swatches panel 
Contains available colors that can be 
selected for use as a foreground or 
background color. (You can also add 
your own colors.) 
 
Target 
When sampling a color, the image that 
will receive the matched color. 

 
 

 
 
Card-Marking 3 / Section 6  
Placing Type in an Image 
 
Distance 
Determines how far a shadow falls 
from the text. This setting is used by 

the Drop Shadow and Bevel and 
Emboss styles. 
 
Distort filters 

Create 3-dimensional or other 
reshaping effects. Some of the types 
of effects you can produce include 
Glass, Pinch, Ripple, Shear, Spherize, 
Twirl, Wave, and ZigZag. 



 
Drop shadow 
A style that adds what looks like a 
colored layer behind the selected type 
or object. 
Font 
A set of characters with a similar 
appearance, size, and color. 
 
Font family 
A complete set of characters, letters, 
and symbols for a particular typeface. 
 
Layer styles 
Effects which can be applied to a type 
or image layer. 
 
Leading 
Changing the amount of space 
between lines of type, to add or 
decrease the distance between lines of 
text. 
 

Rasterized 
Converted into a bitmapped object. 
 
 
Sans serif fonts 
Fonts that do not have a tail, or stroke, 
at the end of some characters, and are 
commonly used in headlines. 
 
Serif fonts 
Fonts that have a tail, or stroke, at the 
end of some characters. 
 
 
Shading 
Collection of Bevel and Emboss 
settings that determine lighting effects. 
 
Style 
A collection of formatting attributes that 
can be saved and applied to specific 
characters or an entire paragraph. 
 

Symbol fonts 
Used to display unique characters 
(such as $, +, or #). 
 
Type 
Text. You can change its appearance 
by using different fonts (also called 
typefaces) and colors. 
 
Type spacing 
Finite adjustments to the space 
between characters and between lines 
of type. 
 
Typeface 
A set of characters with a similar 
appearance, size, and color. 
 
Vector fonts 
Also called Outline type, it is 
mathematically defined, which means 
that it can be scaled to any size 
without losing its sharp, smooth edges. 

 
 

 
 
   



 
File Extensions Explained 
 
Each of us comes across dozens of different file types daily. They end in three or four letters 
and for the most part we know what to expect when we see the most common ones. While 
you may know to expect an image when you read .jpg or text when you see .doc or .docx, 
that doesn’t mean you know what these extensions mean and how best to use them. Here 
is a brief overview of some of the most common file extensions and some of their use 
cases. 
 
.jpg or .jpeg (Joint 

Photographic Experts Group) – The most common file 
format on the web, JPGs are compressed image files. 
Images can be compressed to varying degrees making the 
file smaller but eventually adding noticeable artifacts and a 
grainy texture. JPGs are great for displaying photos online 
when perfect quality is not as important as fast load times. 

.gif (Graphics Interchange Format) – One of the more 
limited file formats, GIFs are limited to displaying no more 
than 256 colors. This makes photographs and any graphic 
with a gradient look low quality, while images with few 
colors can benefit from the small file size. GIFs also allow for 
transparency and animation. 

.png (Portable Network Graphic) – Produced as a 
successor to the GIF, PNGs support many more colors than 
the GIF extension. PNG files tend to be larger than JPEG 
images; however, they have the ability to incorporate 
transparent backgrounds. Though often larger in size than 
JPEGs, PNGs are useful for web designs that require 
transparency or where quality is a premium. 

.tif or .tiff (Tagged Image File Format) – These files are 
commonly used by printers and photographers. They are 
uncompressed and therefore are going to be larger than  

JPGs and PNGs. TIFs are widely supported by most image editing and viewing programs but cannot be displayed by most web 
browsers. 

.eps (Encapsulated PostScript) – This format can store both bitmap and vector graphics. The advantage of vector graphics is 
their infinite scalability. EPS files can be opened by nearly all illustration and graphics programs but cannot be displayed on the 
web. This format is best for logos or graphics that may be printed at varying sizes. 

.pdf (Portable Document Format) – A file system developed by Adobe, PDFs are highly flexible and widely used. Depending on 
how the file is exported it can contain typefaces, layers, raster and vector files, as well as text. PDF files are capable of containing 
both vector and bitmap content editable by Adobe Illustrator and Photoshop. 

.ai and .psd (Adobe Specific Formats) – Adobe Illustrator and Photoshop are two of the most common image manipulation 
programs. AI and PSD file types are the default output of these programs and store all information and settings, such as layers and 
masks, which have been applied to the image. While these images cannot be displayed on the web, they are good to keep around 
in case you ever want to edit the image in the future. 



 


